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1. System configuration 

The system configuration of Servo Drive Series LinRS Interface for the TOP and LinMot is as follows: 
 

Series CPU Link I/F 
Communication 

method 
System setting Cable 

Servo 

Drive 

B1100 

E1100 

E1200 

E1400 

Port on CPU 

(X5) 
RS-232C 

 3.1 Settings 

example 1 

(Page 4) 

5.1. Cable table 1 

(Page 10) 

Port on CPU 

(X5, X7/X8) 
RS-422 

3.2 Settings example 

2 

(Page 5) 

5.2. Cable table 2 

(Page 11) 

Port on CPU 

(X5, X7/X8) 
RS-485 

3.3 Settings example 

3 

(Page 6) 

5.3. Cable table 3 

(Page 12) 

 

 

■ Connectable configuration 

 

ㆍ1:1 connection (one MASTER and one TOP) connection 

 

ㆍ1:N connection (one MASTER and multiple TOPs) connection 
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2. External device selection 

■ Select a TOP model and a port, and then select an external device. 
 

 

 
 

 
 

 

Settings Contents 

TOP Model Check the TOP display and process to select the touch model. 

External device Vendor Select the vendor of the external device to be connected to TOP. 

Select “LINMOT”. 

PLC Select an external device to connect to TOP. 
 

Model Interface Protocol 

LINRS Computer Link LinRS 
 

Please check the system configuration in Chapter 1 to see if the external device you want to 

connect is a model whose system can be configured. 
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3. TOP communication setting 

The communication can be set in TOP Design Studio or TOP main menu. The communication should be set in the same way as that 

of the external device. 
 

3.1 Communication setting in TOP Design Studio 

(1) Communication interface setting 

■ [Project > Project Property > TOP Setting] → [Project Option > “Use HMI Setup” Check > Edit > Serial] 

– Set the TOP communication interface in TOP Design Studio. 

 
 

 
 

 

Items TOP External device Remarks 

Signal Level (port) RS-422C RS-422C  

Baud Rate 57600  

Data Bit 8  

Stop Bit 1  

Parity Bit NONE  

* The above settings are examples recommended by the company. 

 

Items Description 

Signal Level Select the serial communication method between the TOP and an external device. 

Baud Rate Select the serial communication speed between the TOP and an external device. 

Data Bit Select the serial communication data bit between the TOP and an external device. 

Stop Bit Select the serial communication stop bit between the TOP and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP and an external device. 
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 (2) Communication option setting 

■ [Project > Project Property > Device Setting > COM > “PLC1 : LINRS”] 

– Set the options of the MICREX-SX Series communication driver in TOP Design Studio. 

 

 

Items Settings Remarks 

Interface Select “Computer Link”. 
 

Protocol Select the serial communication protocol between the TOP and an external device. 

TimeOut (ms) Set the time for the TOP to wait for a response from an external device.  

SendWait (ms) Set the waiting time between TOP’s receiving a response from an external device and 

sending the next command request. 
 

NODEID Prefix  
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3.2. Communication setting in TOP  

* This is a setting method when "Use HMI Setup" in the setting items in "3.1 TOP Design Studio" is not checked. 
 

■ Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

   

(1) Communication interface setting 

■ [Main Screen > Control Panel > Serial] 
 

 

Items TOP External device Remarks 

Signal Level (port) RS-422 RS-422  

Baud Rate 57600  

Data Bit 8  

Stop Bit 1  

Parity Bit none  

* The above settings are setting examples recommended by the company. 
 

Items Description 

Signal Level Select the serial communication method between the TOP and an external device. 

Baud Rate Select the serial communication speed between the TOP and an external device. 

Data Bit Select the serial communication data bit between the TOP and an external device. 

Stop Bit Select the serial communication stop bit between the TOP and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP and an external device. 
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 (2) Communication option setting 

■ [Main Screen > Control Panel > PLC] 
 

 

Items Settings Remarks 

Interface Select “Computer Link”. 
 

Protocol Select the serial communication protocol between the TOP and an external device. 

TimeOut (ms) Set the time for the TOP to wait for a response from an external device.  

SendWait (ms) Set the waiting time between TOP’s receiving a response from an external device and 

sending the next command request. 
 

NODEID Prefix  
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3.3 Communication diagnostics 

■ Check the interface setting status between the TOP and an external device. 

- Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

- Check if the COM port settings you want to use in [Control Panel > Serial] are the same as those of the external device. 

 

■ Diagnosis of whether the port communication is normal or not 

- Touch "Communication diagnostics" in [Control Panel > PLC]. 

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status. 

OK Communication setting normal 

Time Out Error Communication setting abnormal 

- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet) 

 

■ Communication diagnostics sheet 

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below. 

Items Contents Check Remarks 

System 

configuration 

How to connect the system OK NG 
1. System configuration 

Connection cable name OK NG 

TOP Version information OK NG 

2. External device selection 

3. Communication setting 

Port in use OK NG 

Driver name OK NG 

Other detailed settings OK NG 

Relative prefix Project setting OK NG 

Communication 

diagnostics 
OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

External device CPU name OK NG 

4. External device setting 

Communication port name (module name) OK NG 

Protocol (mode) OK NG 

Setup Prefix OK NG 

Other detailed settings OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

Check address range  

OK NG 

6. Supported addresses 

(For details, please refer to the PLC 

vendor's manual.) 
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4. External device setting 

 

Refer to the vendor’s user manual to identically configure the communication settings of the external device to that of the TOP. 
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5. Cable table 

This chapter introduces a cable diagram for normal communication between the TOP and the corresponding device. 

(The cable diagram described in this section may differ from the recommendations of “LINRS”) 
 

5.1. Cable table 1 

■ 1:1 connection 

■ RS-232C wiring  
 

TOP COM 

Cable connection 

PLC 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

CD 1  1 485 Tx+ 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RD 2 2 232 Tx 

SD 3 3 232 Rx 

DTR 4 4 485 Rx+ 

SG 5 5 GND 

DSR 6 6 485 Rx– 

RTS 7 7 485 Tx– 

CTS 8 8  

 9 9  

RS-485 wiring 

TOP COM 

Cable connection 

External device 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RDA 1  1 485 Tx+ 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin female 

(female, convex) 

RDB 4 7 485 Tx– 

SDA 6 4 485 Rx+ 

SDB 9 6 485 Rx– 

    

    

    

    

    

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 External device connection manual for TOP Design Studio 11 / 19 

2. RS-422 wiring  

TOP COM 

Cable connection 

E1100/E1200/B1100 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RDA 1  3 485 Tx+ 

X7/X8 Port 

RDB 4 6 485 Tx– 

SDA 6 1 485 Rx+ 

SDB 9 2 485 Rx– 

    

    

    

    

    

RS-485 wiring 

TOP COM 

Cable connection 

E1100/E1200/B1100 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 

Pin 

number 

Signal 

name 

Pin 

arrangement*Note 1) 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RDA 1  3 485 Tx+ 

X7/X8 Port 

RDB 4 6 485 Tx– 

SDA 6 1 485 Rx+ 

SDB 9 2 485 Rx– 
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6. Supported addresses 

The devices available in TOP are as follows:  

The device range (address) may differ depending on the CPU module series/type. The TOP series supports the maximum address 

range used by the external device series. Please refer to each CPU module user manual and be take caution to not deviate from the 

address range supported by the device you want to use. 

 

■ Status data 

Device Name Bit Address Word Address Remarks 

Control word ––––– CTRL *1) *3) 

Status word STAT0 – STAT15 ––––– *2) *4) 

Warn word WARN0 – WARN15 ––––– *2) *5) 

Error info message  ALM *2) *6) 

*1) Write only  *2) Read only 

*3) Use word data. Control details according to bit are as follows: 

BIT 0 Switch on/off BIT 4 Abort BIT 8 Jog move + BIT 12 Clearance check 

BIT 1 Voltage enable BIT 5 Freeze BIT 9 Jog move – BIT 13 Go to initial position 

BIT 2 Quick stop BIT 6 Go to position BIT 10 Special mode BIT 14 Reserved 

BIT 3 Enable operation BIT 7 Error acknowledge BIT 11 Home BIT 15 Phase search 

*4) Details depending on bit are as follows.  

BIT 0 Operation Enabled BIT 4 Voltage enable BIT 8 Event handler active BIT 12 Fatal error 

BIT 1 Switch on active BIT 5 Quick stop BIT 9 Special motion active BIT 13 Motion active 

BIT 2 Enable operation BIT 6 Switch on locked BIT 10 In target position BIT 14 Range indicator 1 

BIT 3 Error BIT 7 Warning BIT 11 Homed BIT 15 Range indicator 2 

*5) Details depending on bit are as follows.  

BIT 0 Motor hot sensor BIT 4 Position lag always BIT 8 PTC sensor 1 hot BIT 12 Reserved 

BIT 1 Motor short time overload 

I^2t 

BIT 5 Position lag standing BIT 9 Reserved PTC 2 BIT 13 Reserved 

BIT 2 Motor supply voltage low BIT 6 Controller hot BIT 10 RR hot calculated BIT 14 Interface warn flag 

BIT 3 Motor supply voltage high BIT 7 Motor not homed BIT 11 Reserved BIT 15 Application warn flag 

*6) Displays string. (Max 32 characters) 

 

 

■ Memory data 

Device Name Bit Address Word Address Remarks 

RAM value ––––– RAM0 – RAMFFFF  

ROM value ––––– ROM0 – ROMFFFF  

 

■ Program Handling Message Group 

Device Name Bit Address Word Address Remarks 

R00A ––––– R00A Reset Drive with Response after completion , 1 

R00B ––––– R00B Reset Drive with immediate Response , 1 

*1) Write only 

 

 

☞ Continued on next page.
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■ Motion Control  

* The devices in this area execute variables using bound reference variables.  

(Example) “S00B”(Write Interface Control Word) refers to “_S00B1” as the Interface Control Word data for exection. 

* However, if the reference variables are not entered into the table, they are not used. 

 

* Motion Control – 00 Group 

Device Name 
Bit  

Address 

Word 

Address 
Remarks 

Write Interface Control Word Run S00B ––––– *1) 

 Interface Control Word ––––– _S00B1  

Write Live Parameter Run S00C ––––– *1) 

 UPID (Unique Parameter ID) ––––– _S00C1  

 
Parameter Value, the Unit 

depends on Parameter 
––––– _S00C2  

Master Homing Run S00J ––––– *1) 

 Home Position ––––– _S00J1  

Write X4 Intf Outputs with Mask 

Run S00D ––––– *1) 

Bit Mask; Bit 0 = X4.3 Bit 1 

= X4.4 
––––– _S00D1  

Bit Value; Bit 0 = X4.3, Bit 1 

X4.4… 
––––– _S00D2  

Write X6 Intf Outputs with Mask 

Run S00E ––––– *1) 

Bit Mask; Bit 0 = X6.9 Bit 1 

= X6.22… 
––––– _S00E1  

Bit Values; Bit 0 = X6.9, Bit 

1 X6.22, ... 
––––– _S00E2  

*1) Write only 

 

* Motion Control – 01 Group 

Device Name  
Bit  

Address 

Word 

Address 
Remarks 

VAI Go To Pos Run S01A ––––– *1) 

 Target Position ––––– _S01A1  

 Maximal Velocity ––––– _S01A2  

 Acceleration ––––– _S01A3  

 Deceleration ––––– _S01A4  

VAI Go To Pos After Actual Command Run S01I ––––– *1) 

 Target Position ––––– _S01I1  

 Maximal Velocity ––––– _S01I2  

 Acceleration ––––– _S01I3  

 Deceleration ––––– _S01I4  

VAI Go To Analog Pos Run S01J ––––– *1) 

 Maximal Velocity ––––– _S01J1  

 Acceleration ––––– _S01J2  

 Deceleration ––––– _S01J3  

VAI Go To Pos On Rising Trigger Event 

Run S01K ––––– *1) 

Target Position ––––– _S01K1  

Maximal Velocity ––––– _S01K2  

Acceleration ––––– _S01K3  

Deceleration ––––– _S01K4  

VAI Increament Target Pos On Rising Trigger Event 

Run S01L ––––– *1) 

Target Position ––––– _S01L1  

Maximal Velocity ––––– _S01L2  

Acceleration ––––– _S01L3  
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 Deceleration ––––– _S01L4  

VAI Go To Pos On Falling Trigger Event 

Run S01M ––––– *1) 

Target Position ––––– _S01M1  

Maximal Velocity ––––– _S01M2  

Acceleration ––––– _S01M3  

Deceleration ––––– _S01M4  

VAI Increament Target Pos On Falling Trigger Event 

Run S01N ––––– *1) 

Target Position ––––– _S01N1  

Maximal Velocity ––––– _S01N2  

Acceleration ––––– _S01N3  

Deceleration ––––– _S01N4  

*1) Write only 

* Motion Control – 02 Group 

Device Name  
Bit  

Address 

Word 

Address 
Remarks 

Predef VAI go to pos Run S02A ––––– *1) 

 Position Increment ––––– _S02A1  

Predef VAI Increment Dem pos Run S02B ––––– *1) 

 Position Increment ––––– _S02B1  

Predef VAI Increment Target pos Run S02C ––––– *1) 

 Target Position ––––– _S02C1  

*1) Write only 

 

* Motion Control – 04 Group 

Device Name  
Bit  

Address 

Word 

Address 
Remarks 

Time Curve With Default Parameters Run S04A ––––– *1) 

 Curve ID ––––– _S04A1  

Time Curve To Pos With Adjustable Time Run S04D ––––– *1) 

 Curve ID ––––– _S04D1  

 Target Position ––––– _S04D2  

 Curve Time ––––– _S04D3  

Time Curve To Pos With Adjustable Time On Rising 

Trigger Event 

Run S04K ––––– *1) 

Target Position ––––– _S04K1  

Maximal Velocity ––––– _S04K 2  

Acceleration ––––– _S04K 3  

Time Curve To Pos With Adjustable Time On falling 

Trigger Event 

Run S04L ––––– *1) 

Target Position ––––– _S04L1  

Maximal Velocity ––––– _S04L2  

Acceleration ––––– _S04L3  

*1) Write only 

☞ Continued on next page.
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* Motion Control – 06 Group 

Device Name  
Bit  

Address 

Word 

Address 
Remarks 

Setup Encoder CAM On Rise Trigger Event With Delay Counts Run S06J ––––– *1) 

 Curve ID ––––– _S06J1  

 Curve Start Delay Count ––––– _S06J2  

*1) Write only 

 

* Motion Control – 0C Group 

Device Name  
Bit  

Address 

Word 

Address 
Remarks 

VAI Dec=Acc Go To Pos Run S0CA ––––– *1) 

 Target Position ––––– _S0CA  

 Maximal Velocity ––––– _S0CA  

 Acceleration = Deceleration ––––– _S0CA  

VAI Dec=Acc Increment Dem Pos Run S0CB ––––– *1) 

 Target Position ––––– _S0CB  

 Maximal Velocity ––––– _S0CB  

 Acceleration = Deceleration ––––– _S0CB  

VAI Dec=Acc Increment Target Pos Run S0CC ––––– *1) 

 Target Position ––––– _S0CC  

 Maximal Velocity ––––– _S0CC  

 Acceleration = Deceleration ––––– _S0CC  

*1) Write only 

 

 

* Motion Control – 10 Group 

Device Name  
Bit  

Address 

Word 

Address 
Remarks 

Encoder CAM Enable Run S10A ––––– 1) 

Encoder CAM Disable Run S10B ––––– 1) 

Encoder CAM Go To Sync Pos Run S10C ––––– 1) 

Encoder CAM Set Value Run S10E ––––– 1) 

 Counter Value ––––– _S10E  

*1) Write only 

 

☞ Continued on next page.
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* Motion Control – 11 Group 

Device Name  
Bit  

Address 

Word 

Address 
Remarks 

Encoder CAM 1 Define Curve With Default Parameters Run S11A ––––– 1) 

 Curve ID ––––– _S11A  

 Curve Start Count ––––– _S11A  

Encoder CAM 1 Define Curve From Act Pos Run S11B ––––– 1) 

 Curve ID ––––– _S11B  

 Curve Start Count ––––– _S11B  

Encoder CAM 1 Define Curve To Pos Run S11C ––––– 1) 

 Curve ID ––––– _S11C  

 Curve Start Count ––––– _S11C  

 Target Position ––––– _S11C  

Encoder CAM 1 Define Curve From Pos To Pos In Counts Run S11D ––––– 1) 

 Curve ID ––––– _S11D  

 Curve Start Count ––––– _S11D  

 Start Position ––––– _S11D  

 Target Position ––––– _S11D  

 CAM Length In Counts ––––– _S11D  

Encoder CAM 1 Define Curve To Pos In Counts Run S11E ––––– 1) 

 Curve ID ––––– _S11E  

 Curve Start Count ––––– _S11E  

 Target Position ––––– _S11E  

 CAM Length In Counts ––––– _S11E  

Encoder CAM 1 Define Curve with Amplitude Scale In Counts Run S11F ––––– 1) 

 Curve ID ––––– _S11F  

 Curve Start Count ––––– _S11F  

 Amplitude Scale ––––– _S11F  

 CAM Length In Counts ––––– _S11F  

Encoder CAM 1 Enable Run S11G ––––– 1) 

Encoder CAM 1 Disable Run S11H ––––– 1) 

Encoder CAM 1 Change Amplitude Scale and Length Run S11I ––––– 1) 

 Amplitude Scale ––––– _S11I  

 CAM Length In Counts ––––– _S11I  

*1) Write only 

 

 

☞ Continued on next page.
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* Motion Control – 12 Group 

Device Name  
Bit  

Address 

Word 

Address 
Remarks 

Encoder CAM 2 Define Curve With Default Parameters Run S12A ––––– 1) 

 Curve ID ––––– _S12A  

 Curve Start Count ––––– _S12A  

Encoder CAM 2 Define Curve From Act Pos Run S12B ––––– 1) 

 Curve ID ––––– _S12B  

 Curve Start Count ––––– _S12B  

Encoder CAM 2 Define Curve To Pos Run S12C ––––– 1) 

 Curve ID ––––– _S12C  

 Curve Start Count ––––– _S12C  

 Target Position ––––– _S12C  

Encoder CAM 2 Define Curve From Pos To Pos In Counts Run S12D ––––– 1) 

 Curve ID ––––– _S12D  

 Curve Start Count ––––– _S12D  

 Start Position ––––– _S12D  

 Target Position ––––– _S12D  

 CAM Length In Counts ––––– _S12D  

Encoder CAM 2 Define Curve To Pos In Counts Run S12E ––––– 1) 

 Curve ID ––––– _S12E  

 Curve Start Count ––––– _S12E  

 Target Position ––––– _S12E  

 CAM Length In Counts ––––– _S12E  

Encoder CAM 2 Define Curve with Amplitude Scale In Counts Run S12F ––––– 1) 

 Curve ID ––––– _S12F  

 Curve Start Count ––––– _S12F  

 Amplitude Scale ––––– _S12F  

 CAM Length In Counts ––––– _S12F  

Encoder CAM 2 Enable Run S12G ––––– 1) 

Encoder CAM 2 Disable Run S12H ––––– 1) 

Encoder CAM 2 Change Amplitude Scale and Length Run S12I ––––– 1) 

 Amplitude Scale ––––– _S12I  

 CAM Length In Counts ––––– _S12I  

*1) Write only 

 

 

☞ Continued on next page.
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* Motion Control – 20 Group 

Device Name  
Bit  

Address 

Word 

Address 
Remarks 

Start Command Table Command Run S20A ––––– 1) 

 Command Table ID  _S20A  

Start Command Table Command On Rising Trigger Event Run S20B ––––– 1) 

 Command Table ID ––––– _S20B  

Start Command Table Command On Falling Trigger Event Run S20C ––––– 1) 

 Command Table ID ––––– _S20C  

Modify Command Table 16 bit Parameter in RAM Run S20I ––––– 1) 

 Command Table ID ––––– _S20I  

 Parameter Offset ––––– _S20I  

 Parameter Value ––––– _S20I  

Modify Command Table 32 bit Parameter in RAM Run S20J ––––– 1) 

 Command Table ID ––––– _S20J  

 Parameter Offset ––––– _S20J  

 Parameter Value ––––– _S20J  

*1) Write only 

 

* Motion Control – 24 Group 

Device Name  
Bit  

Address 

Word 

Address 
Remarks 

Set Cmd Table Var 1 To Run S24A ––––– 1) 

 Set value ––––– _S24A  

Add To Cmd Table Var 1 Run S24B ––––– 1) 

 Add value ––––– _S24B  

Set Cmd Table Var 2 To Run S24C ––––– 1) 

 Set value ––––– _S24C  

Add To Cmd Table Var 2 Run S24D ––––– 1) 

 Add value ––––– _S24D  

Write Cmd Table Var 1 To UPID RAM value Run S24I ––––– 1) 

 UPID ––––– _S24I  

Write Cmd Table Var 2 To UPID RAM value Run S24J ––––– 1) 

 UPID ––––– _S24J  

Write UPID RAM value To Cmd Table Var 1 Run S24M ––––– 1) 

 UPID ––––– _S24M  

Write UPID RAM value To Cmd Table Var 2 Run S24N ––––– 1) 

 UPID ––––– _S24N  

*1) Write only 

 
 

* Motion Control – 38 Group 

Device Name  
Bit  

Address 

Word 

Address 
Remarks 

VAI Go To Pos With Force Ctrl Limit Run S38A ––––– 1) 

 Target Position ––––– _S38A1  

 Maximal Velocity ––––– _S38A2  

 Acceleration ––––– _S38A3  

 Force Limit ––––– _S38A4  

VAI Go To Pos From Act Pos And Reset Force 

Control 

Run S38B ––––– 1) 

Target Position ––––– _S38B1  

Maximal Velocity ––––– _S38B2  

Acceleration ––––– _S38B3  

Deceleration ––––– _S38B4  
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Force Ctrl Change Target Force 

Run S38C ––––– 1) 

Target Force ––––– _S38C1  

VAI Go To Pos With Force Ctrl Limit and Target 

Force 

Run S38D ––––– 1) 

Target Position ––––– _S38D1  

Maximal Velocity ––––– _S38D2  

Acceleration ––––– _S38D3  

Force Limit ––––– _S38D4  

Target Force ––––– _S38D5  

VAI Go To Pos With Lower Force Ctrl Limit 

Run S38E ––––– 1) 

Target Position ––––– _S38E1  

Maximal Velocity ––––– _S38E2  

Acceleration ––––– _S38E3  

Force Limit ––––– _S38E4  

VAI Go To Pos With Lower Force Ctrl Limit  and 

Target Force 

Run S38F ––––– 1) 

Target Position ––––– _S38F1  

Maximal Velocity ––––– _S38F2  

Acceleration ––––– _S38F3  

Force Limit ––––– _S38F4  

Target Force ––––– _S38F5  

*1) Write only 

 


